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 Add/Edit Content

 


 

A range of options to add and edit content is available in PDF-XChange Editor. These options are available in the Home tab:

 



Figure 1. Home Tab, Content Editing Tools

 

These tools are used to edit the base content of documents and add text, images and barcodes to the base content layer of documents. Please note that the Content pane is a useful feature to use in conjunction with the content editing tools.

 

		Edit Objects Tool


	 

Click Edit Objects to select and edit document content:

 



Figure 2. Edit Objects Tool

 

Click the Edit Objects dropdown menu to view content selection/editing options:

 



Figure 3. Home Tab, Edit Objects Tool, Content Options

 

•Click All to select/edit text, images and shapes simultaneously when the Edit Objects tool is enabled.
•Select Text Elements to edit only text when the Edit Objects tool is enabled.
•Select Images to edit only images when the Edit Objects tool is enabled.
•Select Shapes to edit only shapes when the Edit Objects tool is enabled. Shapes are defined as paths, shading, XForms and all other document base content that is neither text nor imaged-based.
 

When the Edit Objects Tool is selected, click to select content items, or click and drag to group-select content items. Note that group-selected items are edited simultaneously. Selected content items appear as below:

 



Figure 4. Selected Content Item

 

•Click and drag the yellow control points to resize content. 
•Click and drag the circle at the center to reposition content.
•Click and drag the green control point at the top to rotate content items. Hold down Shift to rotate at increments of fifteen degrees.
•Use the arrow keys to reposition content. Hold down Shift to move at an increased increment.
•Use the editing aids detailed here to assist in the precise placement of document content.
•Press Ctrl+' to open the Properties pane for selected content and view/edit properties. Note that not all properties are editable.
•Click the Format tab to format selected content, as detailed below:
 

Format Tab for Images

 



Figure 5. Format Tab for Images

 

•Use the Opacity dropdown menu to determine the transparency of the image.
•Use the Blend Mode to determine the blend mode used when content overlaps with other content, as detailed here.
•Click Edit to edit the image in either the default application for editing images or an alternative application.
•Click Save to save the image to file.
•Click Recompress to recompress the image, as detailed below.
•Click Replace to replace the image with an alternative image.
•Click OCR to perform optical character recognition on the image.
•Click Properties to view/edit the properties of the image.
 

Format Tab for Text

 



Figure 6. Format Tab for Text

 

•Use the Fill Color dropdown menu to determine the color of the text.
•Use the Stroke Color dropdown menu to determine the border color of the text.
•Use the Width dropdown menu to determine the width of the Stroke Color.
•The Border option is not available for text.
•Use the Opacity and Stroke Opacity dropdown menus to determine the level of transparency of the Fill Color and Stroke Color respectively.
•Use the Blend Mode to determine the blend mode used when text overlaps with other content, as detailed here.
•Use the Font and Font Size settings to determine the font used and the size of the font.
•Use the Bold, Italic and Alignment options to enable/disable bold and italic and/or adjust the alignment of text as desired.
•Use the Grow Font and Shrink Font options to increase/decrease the size of the font.
•Click Properties to view/edit the properties of selected text.
 

Format Tab for Shapes

 



Figure 7. Format Tab for Shapes

 

•Use the Fill Color dropdown menu to determine the color of the shape.
•Use the Stroke Color dropdown menu to determine the border color of the shape.
•Use the Width dropdown menu to determine the width of the Stroke Color.
•The Border option is not available for shapes.
•Use the Opacity and Stroke Opacity dropdown menus to determine the level of transparency of the Fill Color and Stroke Color respectively.
•Use the Blend Mode to determine the blend mode used when shapes overlap with other content, as detailed here.
•Click Properties to view/edit the properties of selected shapes.
 

Editing Shapes/Paths/Objects

 

Double-click shapes, or right-click shapes and and select Edit Object in the shortcut menu, to open the Edit Path tab in order to edit paths:

 



Figure 8. Edit Path Tab

 

You can use the options in this tab to edit paths as follows:

 

•Click Line, Corner Rectangle, 3-Point Rectangle, Parallelogram, Circle, Perimeter Circle, Centerpoint Arc, 3-Point Arc or Ellipse to expand the selected path with the shape indicated, then click and drag to create the shape.
•Click Add Polyline to expand the selected path with a polyline, then click within the document to determine the shape of the polyline.
•Click Add Bezier to expand the selected path with a bezier curve, then click within the document to determine the shape of the curve.
•Click Add Free Paint to expand the selected path in freehand, then click and drag within the document to determine the created shape.
 

You can use the options on the left side of the Edit Path tab when you have selected a line within a path:

 

•Click Add Point to add a point to the line.
•Click Delete to delete the line.
•Click Close Path to complete the shape of paths that have open ends.
•Click Break Apart to break apart lines at points.
•Click Reverse to reverse sub-paths.
•Click Convert to Line to convert bezier curves to lines.
•Click Convert to Bezier to convert lines to bezier curves.
•Click Corner to specify the use of a corner for selected bezier handles.
•Click Straight to specify the use of a straight edge for selected bezier handles.
•Click Smooth to specify the use of a smooth edge for selected bezier handles.
 

Click Finish Editing to complete the current editing operation, or click Cancel Editing to cancel it.

 

Right-Click Options Menu

 

Right-click content for further options. Please note that available options depend on the format of selected content. The menu below contains all available options:

 



Figure 9. Content Items Right-Click Menu

 

•Hover over Edit Image to view editing options for images:
•Click Default Application to edit the image in the default application for editing images. Note that changes made to images in the application will be updated in the current document when the image is saved.
•Click Open With to select a non-default application with which to edit the image. The Open with dialog box will open. Selected the desired application and click OK to launch it.
•Click Edit/Save Images Without Display Transformations to enable/disable this feature. When it is enabled, images can be edited/saved in the state that they were in when added to the document. All subsequent rotations, transformations and scaling operations applied to the image/page are ignored.
•Click Edit All Image Instances to edit all instances of images simultaneously in documents. When this option is enabled and an image is edited, all identical images in the document will be edited in the same manner.
•Click Replace Image to replace selected images with an image from file. Note that replacement images are automatically scaled to match the dimensions of images that they replace.
•Click Recompress Image to recompress images, as detailed below.
•Click Save Image As to save a copy of selected images to file. The Save File As dialog box will open. Enter a file name in the File name text box, then click Save to save the image.
•Click OCR Image to perform optical character recognition on selected images. The OCR Image dialog box will open. Select the desired language and accuracy then click OK to perform OCR.
•Click Add Bookmark to add a bookmark at the selected location. Further information on bookmarks is available here.
•Hover over Add Link to view the options for adding links:
•Click Add Goto Link to create a link from the selected location to a location within the current document. The Browse for Link Target dialog box will open. Move to and select the desired document location and then click Set Link to create the link.
•Click Add Weblink to create a link from the selected location to an internet location. The Add Action: "Open a Web Link" dialog box will open. Enter the desired URL in the text box and then click OK to create the link.
•Click Add Open File Link to create a link from the selected location to a file on the local computer. The Add Action: "Open a File" dialog box will open. Determine options as detailed here then click OK to create the link.
•Click Add Custom Link to create a custom link. Custom links can be used to create a range of dynamic links, such as links that launch JavaScript actions, move to pages in other documents, open files, execute PDF-XChange Editor commands, reset/submit forms, play sounds and show/hide form fields. The Edit Action List dialog box will open. Determine options as detailed here then click OK to create the link.
•Current Layer displays the current layer to which selected content belongs. Hover over this option to view a list of all layers in the document. Click a layer to move the selected content there, or click New Layer to move the selected content to a new layer. Further information about layers and layer creation is available here.
•Click Hand Tool, Snapshot Tool, Select Text or Zoom In/Out Tool to enable these tools.
•Click Cut, Copy, Paste or Delete to perform these actions on selected content. If you have selected text then additional options are available:
•Click Paste as plain text to paste text as plain text.
•Click Paste as Rich Text to paste text as rich text.
•Hover over Arrange to view arrangement options for selected content:
•Use the Align options to align selected content items.
•Use the Distribute options to distribute selected content items evenly on the horizontal or vertical axis as desired.
•Click Make Same Width/Height/Size to make selected content items the same width/height/size as desired.
•Use the Rotate/Flip options to rotate/flip selected content.
•Click Transform to edit the position, size and/or rotation of selected content, as detailed here.
•Click Duplicate to to duplicate selected content items, as detailed here.
•Click Bring Forward to bring content items forward one step in cases of multiple items overlapping.
•Click Send Backward to send content items back one step in cases of multiple items overlapping.
•Click Bring to Front to bring content items to the front in cases of multiple items overlapping.
•Click Send to Back to send content items to the back in cases of multiple items overlapping.
•Hover over Select to view options for selecting all content of a specific format in documents:
•Click All to select all content items in the document.
•Click Text to select all text in the document.
•Click Images to select all images in the document.
•Click Shapes to select all shapes in the document.
•Click XForms to select all XForms in the document.
•Click Deselect to deselect selected content.
•Click Select Correspondent Thumbnails to select the thumbnails of currently selected content. The corresponding thumbnails will then be selected in the Thumbnails pane.
•Click New Stamp from Selection to create a new stamp from selected content, as detailed here.
•Click New Document from Selection to create a new document from selected content. The new document will open in a new window in PDF-XChange Editor.
•Hover over Export to view export options for selected content, then click Export to Images or Export Selection to Microsoft Word Document/Excel/Powerpoint Presentation as desired. If you are exporting to image format then you can customize options as detailed here. If you are exporting to MS Office format then the Save File dialog box will open. Enter a name/location for the new file and then click Save to export the content.
•Click Properties to open the Page Content Properties pane for selected content. This pane is used to view/edit content properties, as detailed here.
 

Recompress Images

 



Figure 10. Recompress Image Dialog Box

 

•Use the Image options to determine conversion options:
•Use the Convert to dropdown menu to determine the format into which the image is compressed.
•Use the Compress method dropdown menu to determine the compression method.
•Use the JPEG Quality dropdown menu to determine the compression quality.
•Use the Downsampling method to determine the downsampling method used, and the adjacent number boxes to determine the downsampled resolution on the X and Y axes respectively.
•Select the Replace current instance only box to replace only the current instance of the image in documents where the same image is used multiple times.
 

Note that the values in the Image Details pane display details about the current image and the image after compression has taken place using the values entered in the Recompress Image dialog box. Additionally, the preview pane will update according to any changes made.






 

		Add Text/Images/Barcodes to Documents


	 

Click Add to add content to documents:

 



Figure 11. Tools Tab Submenu. Content Editing Tools, Add Options

 

These options are used to add text, images and barcodes to documents:

 

		Add Text


	 

Click Add Text to add text to documents: 

 



Figure 12. Home Tab, Add Content Options

 

When this feature is selected the pointer will become a cross icon. Move the icon to the desired location and click to designate the location of the new text box. Text can then be entered as desired:

 



Figure 13. Add Text Tool Example

 

•Click and drag the central yellow control points on either side of text boxes to resize them horizontally. (Note that it is not possible to resize text boxes vertically until text has been entered into them).
•Click and drag the green control point to rotate text boxes. Hold down Shift to rotate at increments of fifteen degrees.
•Use the editing aids detailed here to assist in the precise placement of text boxes.
•Enter the desired text in the text box. Press Enter to start new lines. The options in the Format tab can be used to adjust the text style, as detailed above.
•Press Insert to enable/disable the 'overtype' feature, which enters text over existing text.
•Right-click text for further options:
 



Figure 14. Editing Options

 

•Click Undo to reverse the most recent action.
•Click Cut to cut selected text to the clipboard.
•Click Copy to copy selected text to the clipboard.
•Click Paste to paste current clipboard text at the selected location.
•Click Paste as plain text to paste current clipboard text as plain text at the selected location.
•Click Select All to select all text in the selected area.
•Click Paragraph to edit paragraph settings, as detailed in (figure 15).
•Click Text Style to update the style of selected text. The following options are available:
•Bold
•Italic
•Underline
•Superscript transforms selected text into superscript, which is used for specific purposes such as detailing chemical compounds.  
•Subscript transforms selected text into subscript, which is used for specific purposes such as detailing mathematical formulae.
•Clear Text Formatting clears formatting from selected text.
•Make Current Text format Default sets the format of selected text as the default format for subsequent text. 
•Apply Default Text Format applies the default text format to selected text.
•Select Hyphenate Text to hyphenate text automatically when it crosses line endings.
 



Figure 15. Paragraph Options

 

•Use the Alignment menu to determine the alignment of paragraphs.
•Use the Indentation number boxes to determine the indentation from the left and right margins, and the Special and By menus to determine hanging options. 
•Use the Spacing options to determine line spacing.
 

Click OK to save paragraph settings.






 

		Add Images


	 

Click Add Image to add images to documents:

 



Figure 16. Tools Tab Submenu. Add Image Tool

 

The Select Image Placement Tool dialog box will open. Click Drag Image Rectangle, then click and drag to determine the location at which the image is inserted. The Open Files dialog box will open. Select an image from the local computer. The Add Image dialog box will open:

 



Figure 17. Add image Dialog Box

 

•Click the folder icon to select an alternative file.
•Select an option to determine how the image is added: 
•As a Stamp adds images as stamp annotations, as detailed here.
•As a Content Item adds images as content items.
 

Please note that stamps and content items feature different editing options.

 

Click Place to add images.






 

		Add Barcodes


	 

Barcodes provide a useful method for the storage of information that barcode readers and mobile devices such as smartphones and tablets can access. Hover over Add QRCode to add barcodes to documents:

 



Figure 18. Add Submenu. Add Barcode

 

Select the type of barcode you want to add to the document. The Select Barcode Placement Tool dialog box will open. Click Drag Barcode Rectangle to add a new barcode. The pointer will become a crosshairs icon. Click and drag to determine the size and location of the barcode. The Add Barcode dialog box will open:

 



Figure 19. Add Barcode Dialog Box

 

•Use the Data type menu to set the format of the data contained in the barcode:
•Free Text is used to store text-based content.
•URL is used to store internet addresses.
•Email is used to store information in email format.
•Telephone Number is used to store information in phone number format.
•Contact (vCard) is a file format standard that is used to store electronic business cards.
•Enter any desired test in the Enter Text window. Barcodes are created automatically when data is entered, and can be viewed in the preview pane.
•Barcode properties are detailed beneath the preview pane and can be edited as desired.
 

Click Place to add the barcode to the document.
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